
 
 
 
 
 

MC_Rack Tutorial:      
Input / Output I/O Relationship 



 

 

 

Information in this document is subject to change without notice. 

 

No part of this document may be reproduced or transmitted without the express written 
permission of Multi Channel Systems MCS GmbH. 

 

While every precaution has been taken in the preparation of this document, the publisher and  
the author assume no responsibility for errors or omissions, or for damages resulting from the use 
of information contained in this document or from the use of programs and source code that may 
accompany it. In no event shall the publisher and the author be liable for any loss of profit or any 
other commercial damage caused or alleged to have been caused directly or indirectly by this 
document. 

 

 

© 2012 Multi Channel Systems MCS GmbH. All rights reserved. 

 

 

Printed: 05. 11. 2010  

 

 

Multi Channel Systems 

MCS GmbH 

Aspenhaustraße 21 

72770 Reutlingen 

Germany 

Fon +49-71 21-90 92 5 -  0 

Fax +49-71 21-90 92 5 -11 

info@multichannelsystems.com 

www.multichannelsystems.com 

 

 

Microsoft and Windows are registered trademarks of Microsoft Corporation. Products that  
are referred to in this document may be either trademarks and/or registered trademarks  
of their respective holders and should be noted as such. The publisher and the author  
make no claim to these trademark. 



 

iii 

Table of Contents 

1 Input / Output (I/O) Curve 5 
1.1 Aim of Experiment 5 
1.2 Preparations 6 
1.3 Extracting the Peak to Peak Amplitude 7 
1.4 Aligning the Electrode Pattern to the Slice 7 
1.5 Deselecting Unused Electrodes 9 
1.6 Defining the Region of Interest 10 
1.7 Plotting the Intensity of the Biological Response 11 
1.8 Extracting the Slope 12 
1.9 Customizing Displays 13 
1.10 Plotting a Slope Curve 14 

 

        2       Saving the Rack and Saving Data                                15 





 

5 

1 Input / Output (I/O) Curve 

1.1 Aim of Experiment 

 

This example file was recorded from an acute hippocampal slice on a microelectrode array 
(MEA) with 64 channels with the aim to analyze the input / output (I/O) relationship of the 
biological response to the electrical stimulation. The magnitude of the synaptic response  
is relevant in this experiment. It can be assessed based on the minimum or peak-to-peak 
amplitude of the field excitatory postsynaptic potential (fEPSP) or on the slope of the initial 
response decay. The latter has the advantage that it is a more linear measure of the EPSP strength 
when population spikes mask the fEPSP. It is, however, more sensitive to noise and more difficult 
to extract with propagating waves of activity. 

The biological sample was 300 μm thick and stemmed from a 22 days old rat. The tissue was 
stimulated with one of the substrate integrated electrodes (# 65). A monopolar electrical 
stimulation with biphasic voltage pulses (duration of 100 μs per phase) with amplitudes from  
500 to 3000 mV, in 250 mV steps, was applied. Individual voltage steps were repeated 5 times  
with a delay of 5 s, that is, 5 x 500 mV, then 5 x 750 mV, then 5 x 1000 mV, and so on.  
The Sync Out signal of the STG (stimulus generator) was used to trigger the recording sweeps, 
with a pre-trigger of 10 ms and a time window of 70 ms.  

This example shows a recording with the new MEA amplifier with blanking circuit (MEA1060-BC), 
featuring a superior stimulus artifact suppression. The Sync Out signal of the STG also triggered 
the MEA amplifier. The electrodes were transiently, in this case for 540 μs (300 μs Sync Out pulse 
of the STG, plus intrinsic Wait of 40 μs, plus user-defined Wait of 200 μs) separated from the 
amplifier stage during stimulation. Stimulus artifacts could be efficiently prevented on all 
recording channels. 

The demo data used in this part of the tutorial was kindly provided by Dr. Frank Hofmann, 
University of Heidelberg, Germany. 
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Task 

Analyze the input / output (I/O) relationship of the biological response to the electrical 
stimulation by an offline analysis; graph, print and save the results. 

Note: In this chapter, you will set up an offline analysis rack (for the demo data file) step by step. 
You can set up a virtual rack for online recordings and analysis likewise, simply add the MC_Card 
as the data source to the rack instead of the Replayer. 

 Rack file: Hippocampus_IOCurve_Demo.rck  

 Data file: I-Ocurve_Demo.mcd  

 Image file: Hippocampus_IOCurve.jpg 

Please see also the MEA Application Notes for more information on the preparation techniques 
and experiments. 

You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Select electrodes of interest / deselect unused electrodes. 

 Analyze field potentials, for example, extract peak-to-peak amplitude and the slope  
in parallel (Analyzer) 

  Plot the extracted parameters vs. time (Parameter Display) 

 How to customize the rack: 

 Modify the display layout (all display types) 

 More details: 

 Align the data traces to a slice picture (Analyzer, Data, or Averager display) 

1.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file "Hippocampus_IOCurve_Demo.rck".  
Click Open on the File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder into the MC_Rack directory with the following path 
"c:\Program Files\Multi Channel Systems\MC_Rack\"  

2. Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file I-Ocurve_Demo.mcd into the Replayer. 
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1.3 Extracting the Peak to Peak Amplitude 

1. For extracting the peak-to-peak amplitude and the slope, we will need an Analyzer.  

Click  on the toolbar to add an Analyzer to the virtual rack. 
 
The triggered Analyzer display with the region of interest appears because the data was 
recorded as triggered sweeps. 

2. Rename the Analyzer to Peak to Peak to distinguish it from the slope analyzer that we will  
set up later. 

3. Select the Analyzer in the tree view pane. Select the parameters you like to extract,  
Peak-Peak Ampl. in this case. 

 

1.4 Aligning the Electrode Pattern to the Slice 

You can load a picture (from a digital camera, for example) of the acute slice as a background 
picture of the display and align the traces to the electrode positions. 

1. On the File menu, click Load Image. 

2. Browse your folders and open the Tutorial folder on the installation volume. 

3. Select the Hippocampus_IOCurve.jpg file and click Open. 

4. On the Analyzer window, click Show Image. You can now see the slice picture. 

5. Now, you map the channels to the electrodes in the picture. Hold down the SHIFT key,  
point to any electrode in the picture, for example, No. 33, and double-click. 
 

 
 
A text box opens. 
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6. Type in the number of the electrode according to the MEA layout, for example 33. 
 

 

7. Hold down the CTRL key, point to any electrode in another row, for example the bottom right, 
and double-click. 

8. Type in the number of the electrode according to the MEA layout, for example 78. 
The electrode numbers appear on top of the picture in the typical 8x8 grid. 
  

9. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 
 
The data traces appear on top of the picture. 

 

Note: If you have made a mistake, simply repeat the assignment from step 58. 

Hint: If you record data with a background picture in your rack, the file path of the picture  
is saved together with the data, that is, it is opened automatically when you replay the file  
in a rack that has a display with the Show Image option selected. (File paths are absolute,  
that means MC_Rack cannot find picture files if they have been moved to another folder or 
directory. You will be informed by an error message.) 
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1.5 Deselecting Unused Electrodes 

One of the main advantages of MC_Rack is the flexible data management. You can now  
deselect any unused electrodes, for example, the electrodes that are not covered by the slice  
or the stimulating electrode, in the Analyzer, so that the peak to peak amplitude is extracted 
only from the selected electrodes. 

Hint: With a MEA Switch, you could use unused channels on the data acquisition board for 
recording from an additional amplifier. 

Note: The Recorder that writes data to the hard disk is an independent virtual instrument,  
that is, you have to select the channel numbers that you want to save in the generated data file, 
for each data stream separately, on the Channels tabbed page of the Recorder. 

1. In the tree view pane of the virtual rack, select the Analyzer, and click the Channels tab. 

2. Click the data stream Electrode Raw Data. 
On the right half of the Channels page, the channels appear in the MEA-layout. You can select 
the check box next to the stream name to select all channels, or click single buttons to pick single 
channels. The check box next to the stream name appears shaded if some, but not all channels 
have been selected. 

3. Deselect the stimulating electrode 65, and all unused electrodes such as 21, 31, 32, 33, 34, 35, 36, 
37, 52, 62, 72, 82, 73, and 83, by clicking the corresponding channel buttons. Selected channel 
buttons appear pressed in. 

 

If you start the rack again, only the traces from selected electrode are displayed and only the peak 
to peak amplitudes from selected electrode channels are extracted. 
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1.6 Defining the Region of Interest 

You have to define a time range relative to the trigger event as the region of interest (ROI).  
The parameter of interest, the peak-to-peak amplitude in this case, is then extracted from the 
data trace in the region of interest. You can define the region of interest with the two vertical 
bars in the Analyzer display or by editing the T1 and T2 boxes on the ROI tabbed page of the 
Analyzer. 

1. Double-click on any electrode with a large response to zoom into the data recorded  
from this electrode. 
 

 
  

2. Position the bars so that the field potential is clearly inside the region of interest.  
As the demo data was recorded with a MEA1060-BC amplifier with blanking circuit,  
there is no stimulus artifact that you would need to exclude from the analysis. 
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1.7 Plotting the Intensity of the Biological Response 

As a measurement for the response to the stimulus, we will plot the peak-peak amplitude  
and the slope versus time. We will start with the peak-peak-amplitude. For graphing  
the extracted data, we will need a Parameter Display. 

 In the tree view pane of the virtual rack, select the Analyzer and click  on the toolbar to add  
a Parameter Display in series with the Analyzer to the virtual rack. (It would not be possible  
to add the Parameter Display in parallel to the Analyzer, as the replayed data file does not 
contain any parameter streams as input streams for the display, and virtual instruments can only 
use the output streams of other virtual instruments that are upstream in the virtual rack tree). 
You can rename it so that you can identify it later in the virtual rack. 

Setting the window extent 

As this demo data file has about 4 min recording time (see File Info page of the Replayer),  
5 min will be fine for the x-axis range. 

1. In the tree view pane of the virtual rack, select the Parameter Display, and click the Ranges tab. 

2. Enter 5 min for the x-axis range, and adjust the y-axis to the maximum response, for example, 
3000 μV. 
 

 

1. Click Start  to generate the plots. You can select the option Display Marker to mark  
each extracted data point in the plot. 

The output is nicely increasing with the increasing stimulus amplitude. 
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1.8 Extracting the Slope 

In triggered mode, the Analyzer extracts the parameters of interest from a distinct time 
window relative to the trigger event, the region of interest (ROI). You could use the same 
Analyzer for extracting both the peak-to-peak amplitude and the slope, but as two distinct 
regions of interest are required for extracting the two parameters, we will need to set up  
a second Analyzer. 

1. Click  on the toolbar to add a second Analyzer to the virtual rack. 

2. Rename the Analyzer to Slope to distinguish it from the first analyzer. 

3. In the tree view pane of the virtual rack, select the Analyzer, and click the Channels tab.  
Select the electrode channels that you would like analyze, for example, channel 55. 

4. Click the Analyzer tab and select the parameters you like to extract, slope in this case. You  
have the choice between four options: Slope is the slope of a straight line fitted through all  
data points in the ROI. When choosing Slope 10% / 90%, only the data points in the range of  
10% / 90% of the peak-peak amplitude (stretching from minimum to maximum) in the region  
of interest is considered for fitting the line. This is generally more useful as the exact timing of  
the regions of interest may differ slightly from channel to channel and it might be difficult to 
position the ROI to fit all channels of interest. 

Select checkbox slope 10% / 90%. 
 

 

Defining the ROI 

For extracting the slope, you need to frame ideally only the linear part of the response  
decay with the ROI cursors. 

1. Zoom into a single channel and use the sliders to adjust the ranges so that you can clearly  
see the linear part of the response decay. 
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2. Define the region of interest with the vertical bars T1 and T2. When choosing the Slope  
10 % / 90 % option, it is not required to position T1 and T2 exactly, as 10 percent, that is,  
the non-linear part of the response, is not regarded. The slope is then computed from a linear  
fit regression line (Least Square Algorithm) in the ROI. 
 

 

1.9 Customizing Displays 

As it may not be useful or possible to extract the slope from all channels, you can set up your 
custom layout for the Analyzer or the Parameter display (this is true for all displays), to save 
space on the screen. You may be interested only in one or two representative channels. 
(Remember: You can save the parameters of all channels in the Recorder to review it later  
or to analyze it further in your custom evaluation software.) 

1. Click the Layout tab. 
The default layout is loaded. In the Rows and Columns boxes, you can now modify the layout. 

2. Type or select the number of Rows, for example 1, and the number of Columns, for example 1. 
On the right, a custom layout with a single channel appears. 

3. Assign the appropriate channel numbers to the empty slots. Click the empty slot to select it.  
The active slot is highlighted by a dotted line. 

4. Select the channel of interest, for example, 55, for the active slot from the Channel list,  
or type 55. The Parameter Display is updated accordingly. Likewise, you can set up any  
custom configuration for all display types. 

 



MC_Rack Tutorial: MEA Application Examples 

14 

1.10 Plotting a Slope Curve 

1. On the toolbar, click  to add a second Parameter Display following the second Analyzer  
to the virtual rack configuration. (If it follows the first Analyzer in the tree view, it will not be 
possible to assign the output data stream of the second Analyzer, that is, the slope, to this 
Parameter Display.) You can rename it so that you will identify it later in the virtual rack. 

2. Adjust the x-axis range to the total recording time of about 5 minutes. 
 

 

3. Start the rack to generate the plot. 

The slope becomes more negative, that is, the decay time decreases,  
with an increasing stimulus amplitude. 
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2 Saving the Rack and Saving Data 

2.1 Saving a Rack 

Save the virtual rack configuration if you like to keep it for future use, for example  
for an offline analysis of identical data recorded in another experiment. 

1. On the File menu, click Save As. 

2. The Save As dialog box opens. 

3. Browse your folders and select a path. 

4. Enter a file name and confirm by clicking Save. 

The file extension for the rack files is .rck. 

2.2 Selecting Data Streams for Recording 

MC_Rack's philosophy is to strictly separate the actions of all virtual instruments in a rack.  
That means, that you could record to hard disk completely different data streams and channels 
than you monitor on the screen. This has the advantage that you can store exactly the channels 
you are interested in, but it also has the slight disadvantage that all virtual instruments have to be 
set up separately. Please be especially careful when configuring the Recorder, to avoid data loss. 

When you have finished setting up the rack, you can select the data streams and channels that 
you want to save to the data file specified in the Recorder. 

Selecting data streams and channels for recording 

The fate of each single channel is independent from other channels. You can pick exactly the 
channels you like to save from all generated data streams. For example, you can decide to save 
only one channel of raw data, but the peak-to-peak amplitude results of all, or of a specific 
selection of channels. 

1. Select the Recorder in the virtual rack tree view pane and then click the Channels tabbed page. 
On the white pane on the left of the Channels page, you see the data streams that are available 
with your rack configuration. When replaying data, you are generally more interested in the 
parameter data streams, but you can rerecord the raw data as well, in case that you want to save 
the raw data and the extracted parameters to the same data file. 
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2. Click the data stream that you are interested in, generally the parameter streams. 
The available electrode channels appear in a button array on the right side. Parameter stream 1  
is generated by the first analyzer in the rack (here: for extracting the peak-peak amplitude), 
parameter 2 is generated by the second analyzer (here: for extracting the slope). 
 

 

3. You can now either select all channels by clicking the check box next to the data stream name,  
or you can pick single channels by clicking the corresponding buttons. For more information, 
please see "Channel Selection" in the MC_Rack Features section. Only data from the selected 
channels will be saved to the hard disk. 

2.3 Creating a Data File 

If you want to write the parameters that you will extract in an offline analysis to the hard disk, 
you have to specify the file name and path in the Recorder. (It is not possible to change or 
overwrite existing data files in MC_Rack, for example, adding the spike rate to an existing data 
file, but you can record the raw data together with the spike rate stream to the same file.) 

Choosing the file name and path 

1. Click the Recorder tab. 

2. Browse your folders and select a path. 

3. Type a file name into the text box. 

4. Confirm by clicking Save. 

The data file is then generated automatically when you start MC_Rack in recording mode.  
The file extension for the data files is *.mcd. 
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File size limit 

When the maximum file size specified by the user has been reached, a new file is generated 
automatically. The file name is extended by four digits, counting up, for example  
LTP-Parameters0001.mcd, LTP-Parameters0002.mcd, and so on. 

If you rather prefer that the recording is completely stopped when a file has reached the 
maximum size, please select the option Auto Stop. 

For information on more options, please see "Generating Data Files" in the MC_Rack Features 
section. 

Selecting data streams and channels 

As has been said before, the fate of each single channel is independent from other channels. 
You can pick exactly the channels you like to save from all generated data streams. For example, 
you can decide to save only one channel of raw data, but the peak-to-peak amplitude results 
of all, or of a specific selection of channels. 

 Click the Channels tab. 

As long as the rack is still empty, you see an empty box. There are no channels available at this 
point, because you have not chosen a data source yet (MC_Card for online data acquisition or 
Replayer for replaying data files). Without a data source, there are no data streams available  
for recording. Remember later, when you have completed the rack, to assign the channels that 
you like to save to the data file to the Recorder. 

After you added a data source, you will see the electrode raw data streams provided by the data 
source (for example, electrode raw data, analog data, and digital data from the MC_Card, or the 
data streams included in the data file loaded into the Replayer). If the rack file contains virtual 
instruments that generate data streams such as Spikes from a Spike Sorter or Parameter streams 
from an Analyzer, these data streams will be available for recording as well. 

2.4 Starting Data Acquisition and Recording 

Now that you have completed the virtual rack, you are ready to start the rack. 

 Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the data acquisition. Each virtual instrument in your rack starts to process the channels 
and data streams that were assigned to it. 

 Click first Record  and then Start  to write data to the hard disk. The data from the 
electrodes selected in the Recorder is saved to the file and location specified in the Recorder. 

 

 Click Stop  to stop the data acquisition. 

 

Warning: Only data of the channels and data streams that were selected in the Recorder are 
saved in your data file when you start a recording. Data is only saved to the hard disk when the 
red Record button is pressed in. Make always sure that you have selected all channels of interest, 
and that the Record button is active before starting an experiment to avoid data loss. 

 


